
What is a terminal emulator ? 
The MultiView 2000 terminal emulators allow you to launch remote UNIX applications from your Windows PC. You can start 
several terminal emulators and simultaneously switch freely between local and remote applications. The most popular terminal 
types can be emulated enabling transfer of information between several types of remote system and your local PC applications.
The terminal emulators are completely configurable to suit your requirements with facilities for changing terminal types, 
connectivity options, fonts, text attributes and keyboard mappings.



When to use a terminal emulator
You can configure and use terminal emulators when you want to run remote UNIX applications from your PC. You can also 
exchange information between remote UNIX applications and local Windows applications.



Terminal Emulator Features
The MultiView 2000 terminal emulator offers the following functionality.

            Complete and accurate emulation of the most popular terminals.
            Full configuration of terminal emulator properties.
            A variety of connectivity options.
            Intelligent graphical representation used for keyboard mapping.
            Transfer of information between local and remote systems using OLE automation or DDE.
            Scripting.
            Unique Active Rules support.



Supported terminal emulators
The following terminal types are fully supported:

DEC VT100, VT220 and VT320
SCO UNIX Console 
WYSE 60



Configuring terminal emulator properties 
The properties of each terminal emulator are fully configurable. These include changing the default font, text attributes, use of 
color, line drawing alternatives, display border, right click popup menu, auxiliary printing, number of lines and columns in the 
window, the number of lines in the scrollback buffer, tasking options and cursor settings.
Once these properties have been set, they can be saved in a configuration file for future terminal emulator sessions.



Connectivity options 
A choice of connectivity options can be used including:

TCP/IP Winsock networks with TELNET, Rlogin, Rexec or Rsh.
Serial connections - RS232 and modem (TAPI implementation).
IPX/SPX with multi-session NVT2.



Keyboard mapping
An easy-to-use graphical utility is available for mapping terminal-style keys to PC-style keys, enabling consistent keyboard input 
to terminal applications regardless of the keyboard in use.
There is a graphical keyboard for each supported terminal type with default mappings already assigned. The mappings can be 
altered and extended as required and saved for future use.



Transfer of information 
Information exchange between applications can be accomplished through OLE automation or Dynamic Data Exchange (DDE). 
See Technical Reference for further details.



Scripting
Scripting allows you to record keyboard input.    This can then be replayed to automate difficult or frequently used tasks. Scripts 
can be played in a number of ways.

Manually, via the terminal emulator Remote menu.
To provide an automatic login to a specified remote system.
Keyboard, by assigning a script file to an appropriate keystroke.    



Active Rules
Active Rules allow for the integration between the Terminal Emulator and other Windows applications based upon a set of rules or
conditions being satisfied. 
· Keywords, such as URL (http, ftp, gopher, …), application links (doc, xls, …) can be set up as hot spots that will launch a web 

browser, or other application. 
· Key sequences can be sent to the UNIX host at the click of a mouse.
· Input fields and any other logical function areas in the UNIX application can be defined as a live hot spot with visual effects.
The rules may be applied system wide, or on an individual application basis.



Terminal Emulator 
Click on the image below to identify the different parts of a terminal emulator.



Title bar contains the window title, minimize , maximize 

 and close 
 window buttons.



Toolbar contains buttons that give you quick mouse access to commonly used commands in the terminal emulator menus.



Menu bar contains terminal emulator menu commands.



Scripting toolbar contains buttons that give you quick mouse access to commonly used script commands in Remote menu.



Main terminal emulator window.



Status bar displays helpful information and messages while you are using the terminal emulator.



Status bar displays the current terminal type being used.



Scrollback bar used for scrolling back the main terminal window.



Color bar contains brightness and contrast controls.





To show or hide the status bar
Click the View menu and click Status Bar.
When the command has a check mark next to it, the status bar is on.



To show or hide the toolbar
Click the View menu and click Toolbar.
When the command has a check mark next to it, the toolbar is on.



To show or hide the color intensity toolbar
Click the View menu and click Color Intensity Bar.
When the command has a check mark next to it, the color intensity toolbar is on.





To start a terminal emulator 
Click here    

    to start a terminal emulator.
    Related Topics



To start a terminal    emulator from the Start menu
1 Click the Start button, and then point to Programs.
2 Point to the MultiView 2000 folder and click Terminal Emulator.

Tip
Repeat these steps to start additional instances of terminal emulators.

    Related Topics



To start a terminal emulator from the command line 
1 Click the Start button, and then click Run.
2 Use the Browse button to find the location of the terminal emulator program (jsbterm.exe) and click OK.

Tips
Add the name of a configuration file (.zzt) to the end of the command in the Open box to open the configuration file on 

startup of a terminal emulator. You will need to include the full path of the configuration file if it is not located in the same directory as
the terminal emulator program.

Alternatively, call a configuration file (.zzt) directly. You will need to include the full path of the configuration file.
    Related Topics



To start a terminal emulator using command line options
The following command line options may be used to run a terminal emulator from the Windows Run command.
Specify the remote system to login to
To start a terminal emulator which remains invisible until a DDE 
connection is made
To override the remote system name specified in 
a configuration file (  .zz  t  )  
Specify a TELNET URL. See URL syntax for more details.
The terminal emulator executable jsbterm.exe must be the first parameter, you may then include the above options.



jsbterm remotesystemname



jsbterm -name=remotesystemname configurationfile.zzt
Uses the specified remote system name rather than the name specified in the configuration file.

jsbterm -name=    configurationfile.zzt
Prompts for a remote system name rather than using the name specified in the configuration file.



jsbterm -s
Optionally, you may include a configuration file.



Allows you to specify a remote system and optionally, a username and password.
Eg. jsbterm telnet://remotesystemname
jsbterm telnet://username@remotesystemname
jsbterm telnet://username:password@remotesystemname



To exit from a terminal emulator 
Click the File Menu and click Exit.

Tip
Click the close 

    button in the top right corner of the terminal emulator window for an alternative way to close the terminal emulator.



To add a terminal emulator

1 Click here        to open the Session Properties dialog box.
2 In the Connection tab, type the name or IP address of a known remote system in Remote System Name.
3 Type your User Name.
4 Click the type of connection to use to connect to the remote system from the Connection Type list.
5 Click the OK button.
6 Click here        to open the Terminal Properties dialog box.

7 Click the down arrow of the Terminal Type box and click a terminal type to be emulated by the terminal emulator.
8 Click the OK button.

Tip
These dialog boxes can be opened from the the Configure menu.

    Related Topics



To connect to a remote system

1 After configuring a terminal emulator, click here        to connect to the remote system.
2 While logging into the remote system, enter the appropriate commands to the login prompts.

Tip
You can connect to a remote system using the Connect command on the Remote menu.

    Related Topics



To disconnect from a remote system
Click here    

    to disconnect from a remote system.

Tip
You can disconnect from a remote system using the Disconnect command on the Remote menu.

    Related Topics



To save a terminal emulator’s properties 
Click the File Menu and click Save.

Tip
To save the current terminal emulator’s information in a different file, click Save As from the File menu. Select the folder 

and type the file name with a .zzt extension.



To load a terminal emulator’s saved properties
1 Click the File menu and click Open.
2 In the Open dialog, select the appropriate folder and click a configuration file.

Note
The configuration files used by a terminal emulator must have the .zzt extension.

Tip
You can select a recently used configuration file from the Recently Used File List in the File menu.

    Related Topics



To save a terminal emulator’s connection details

1 Click here        to open the Properties dialog box.
2 In the Connection tab, click Save As in the File Name for Connection Details box.
3 If you have not saved your file before, type a name for the file in the File Name box and click Save As.

The connection details will be saved in a file with the extension .zzc.

Tip
This dialog box can be opened from the Session command on the Configure menu.

    Related Topics



To load a terminal emulator’s saved connection details
1 Click here        to open the Properties dialog box.

2 In the Connection tab, click Open in the File Name for Connection Details box.
3 Click the file you want to open. You may need to find the drive or folder that contains the configuration file.

Tips
The connection details will be saved in a file with the extension .zzc.
This dialog box can be opened from the Session command on the Configure menu.

    Related Topics



To change the cursor style
1 Click here        to open the Properties dialog box.

2 In the Terminal tab, click Configure and click the Display tab.
3 Click the cursor style you want from the Cursor Settings box and adjust the blink speed using the slider bar.

Tip
This dialog box can be opened from the Terminal command on the Configure menu.



To assign colors to a text attribute used in a terminal emulator
1 Click here        to open the Properties dialog box.

2 In the Attribute Mapping tab,    click Default Text from the attribute list.
3 Use the Foreground and Background Select buttons to select your color(s).

Tips
To view an example of the color mapped, see the sample box after applying a color.
If mapping other attributes, make sure that any combined attributes available in the list are also mapped appropriately.
To add a style to the text, select a style from the Text Style list.
To add a border to the text, select a style from the Border Style list.
This dialog box can be opened from the Appearance command on the Configure menu.

    Related Topics



To assign default colors to a text attribute used in a terminal emulator
1 Click here        to open the Properties dialog box.

2 In the Attribute Mapping tab, click an attribute from the attribute list and click Default.
3 Click the Reset Attribute in the Default dialog box and click OK.

Tips
The background and foreground default colors are obtained from the application.
To set all attributes to their defaults, click the All Attribute option from the Default Attribute dialog box.
This dialog box can be opened from the Appearance command on the Configure menu.

    Related Topics



To add a border to a terminal emulator
1 Click here        to open the Properties dialog box.

2 Click the Patterned Border tab.
3 Click a border style from the list of borders.

Tips
Click None to remove the border from a terminal emulator.
Click browse to locate other bitmaps that can be used as borders.



To change the font size used in a terminal emulator
On the terminal emulator toolbar, click the Font buttons to increase or decrease the size of the font used.

Tips
You can also change the size of the terminal emulator window which then automatically changes the size of font to be 

used.
To use the largest sized font, remove the toolbar and status bar using the View menu. Resize the window by clicking a 

corner of the window and dragging it to accommodate the maximum size of the screen. If you click the window’s Maximize button, 
this may not display the largest font size possible.



To change the font style used in a terminal emulator
1 Click here        to open the Properties dialog box and click the Font tab

2 Select a font from the Font Name box and change the style and size appropriately.

Tips
Click Show only supported True Type Fonts to view the fonts that are fully supported by the terminal emulator.
Click Show all True Type Fonts to view all fonts that may be used by the terminal emulator.

Note: Only supported fonts contain all the characters sets supported by the terminal emulators, some characters may not be 
supported in other fonts, e.g. line drawing. If the font is not of the type fixed pitch, the characters may appear spread out in the 
display during a resize to compensate for a non-fixed pitch font, see the Sample dialog before completing font selection.



To change the number of columns and lines used by a terminal window
1 Click here        to open the Properties dialog box.

2 In the Terminal tab, click Configure and click the Display tab.
3 In the Dimensions box, use the up-down buttons to set the number of columns and lines.

Tip
This dialog box can be opened from the Terminal command on the Configure menu.



To change the number of scrollback lines used by a terminal window
1 Click here        to open the Properties dialog box.

2 In the Terminal tab, click Configure and click the Display tab.
3 In the Dimensions box, use the up-down buttons to set the number of lines in the scrollback buffer.

Tip
This dialog box can be opened from the Terminal command on the Configure menu.



To specify when to update a terminal emulator window 
1 Click here        to open the Properties dialog box and click the General tab.

2 Check Immediate Update to display data in the terminal emulator window as it is received.

Tips
Click to clear this option to update the window at regular unspecified intervals.
This dialog box can be opened from the Session command on the Configure menu.



To suspend updating of an inactive terminal window.
1 Click here        to open the Properties dialog box and click the General tab.

2 Check Suspend Updating when an Inactive Window.

Tip
This dialog box can be opened from the Session command on the Configure menu.



To map keyboard input and output CR and LF sequences
1 Click here        to open the Properties dialog box.

2 In the Terminal tab, click Configure and click the CR/LF Mapping tab.
3 Click the required Keyboard Input and Output map options.

Tip
This dialog box can be opened from the Properties command on the Configure menu.



To specify a sequence to send to obtain a remote application’s help
1 Click here        to open the Properties dialog box and click the Application tab.

2 Type the help sequence in the Sequence box, adding Control Characters as required.

Tip
This dialog box can be opened from the Application command on the Configure menu.



To specify a sequence to send on closure of a terminal emulator
1 Click here        to open the Properties dialog box and click the Closure Options tab.

2 In Action when Close …, click Send Closure Sequence to Remote Application.
3 Type the closure sequence in the Sequence box, adding Control Characters as required.

Tip
This dialog box can be opened from the Application command on the Configure menu.



$ Recording a login procedure in a script file
    Related Topics



To invoke a remote application using a script file
1 Click here        to open the Properties dialog box and click the Application tab.

2 In the Remote Command box, type the command to run the remote application.
3 From the Remote menu, click Learn Script and from the same menu, click Connect.
4 Enter your password and use the Remote menu Send commands to send the appropriate responses to the terminal 
emulator prompts including the Remote Command. To send each menu command, you must press ENTER after clicking the menu 
command or use the Return menu item. 

5 To stop learning, click End Learn from the Remote menu and save the file.

Note
The configuration files used for scripting must have the .zzs extension.

Tips
The Remote menu scripting commands are also available from the scripting toolbar.
For details on script commands, see the Technical Reference.

    Related Topics



To replay a script file
1 From the Remote menu, click Play Script File.
2 Locate and click the .zzs script file to be replayed.
3 Click Open to run the script file.
4 The Connection tab of the Properties dialog box will be displayed just before connecting to a remote system to allow you to 

select the remote system and connection type. Check the Password Required box, if relevant. Click OK.
5 Enter your password when required.



To replay a script file on startup
1 Click here        to open the Properties dialog box and click the Startup tab.

2 Click Auto Replay Script File: and type the full path of the .zzs script file. Alternatively, click the Browse button to locate 
the script file. Click OK.
3 Connect to the remote system.



To copy text within a terminal emulator
Click and hold the mouse button to highlight the text to copy and click Copy from the Edit Menu.

Tip
You can right click in the terminal emulator after highlighting the text to be copied, and use the shortcut menu to select the

Copy command.
    Related Topics



To paste text at a terminal emulator's current cursor position 
After copying some text, click Paste from the Edit Menu.

Tips
You can right click in the terminal emulator after copying some text, and use the shortcut menu to select the Paste 

command.
You can also paste text which has been copied from another application.

    Related Topics



To copy and paste text at a terminal emulator's current cursor position in one action
Click and hold the mouse button to highlight the text to copy and click Quick Copy & Paste from the Edit Menu. The 

highlighted text will be copied and pasted at the current cursor position in the terminal emulator.

Tip
You can right click in the terminal emulator after highlighting some text, and use the shortcut menu to select the Quick 

Copy & Paste command.
    Related Topics



To place copied text into a newly created mail message
Click and hold the mouse button to highlight the text to be used to form the basis of the new message and click Send from

the Edit Menu. The default mailer will be create a new message and the highlighted text will be placed in the body of the message.

Tip
You can right in the terminal emulator after highlighting some text, and use the shortcut menu to select the Send 

command.
    Related Topics



Performing actions on selected text
You can highlight or select text in a terminal emulator and use the Action As right click menu option to carry out one of the 
following actions:
URL Uses the selected text as a URL and runs the relevant MultiView 2000 application to load the URL address.
Local File Uses the selected text as a PC file name to run an application or load the file into an associated application 

located on your PC.
Remote File Uses the selected text as the name of a remote file and runs MultiView 2000 File Transfer to download the file to a

local folder.
Ping Uses the selected text as the name or IP address of a remote system and runs MultiView 2000 MultiPing to test 

the availability of the remote system.
Configurable
menu items Menu items may be added to the bottom of the popup menu which execute a configured command.

    Related Topics



Using the Remote Command Server
The Remote Command Server (RCS) allows PC applications to be launched from the remote system via the command line or 
from a remote application. This can be very useful, for example, when you need a PC file transferred to the remote host without a 
user's intervention. 
The following example could be entered at the remote system's command line to start Windows Notepad:
/usr/bin/echo "\033[xnotepad.exe\033\\"



Mailing selected text
You can highlight or select text in a terminal emulator and send it to a recipient using your default mail application.
Select the text to be sent and click Send from the right click menu.
The text will be placed in a new mail message. Remember to enter the To: mail address within the message and send it.



To add an item to the popup menu
1 Click here        to open the Properties dialog box and click the Popup Menu tab.

2 Click a menu item (below &Action As) beneath which a new menu item is to be added and click Add.
3 In the Title box, enter a menu item name.
4 In the Action box, click the right arrow, select an action and complete the action command. Alternatively type an action in the 

box. 

Tips
To include a parameter in the action command, select Parameter from the action menu at step 4.
To change a current menu item, select the item and click Configure.
To save the popup menu in a configuration file (.zzp), click Save As.

    Related Topics



To use DDE
Please refer to the Technical Reference for full details on how to use DDE.



To send an answer back message to the remote application
1 Click here        to open the Properties dialog box.

2 In the Terminal tab, click Configure and click the Answer Back tab.
3 In the Message box, type the message to be sent by the terminal emulator to the remote application when the terminal 
receives an ENQ (5H) character. Use the Control Characters in the message where necessary.

Note
The answer back facility is only supported by VT terminal emulations.

Tip
This dialog box can be opened from the Properties command on the Configure menu.



To specify a TCP/IP connection
1 Click here        to open the Properties dialog box and click the Connection tab.

2 From the Connection Type list, click a TCP/IP protocol to be used for connections.

Tips
The following TCI/IP protocols are supported:

TELNET
RLOGIN
REXEC
RSH

This dialog box can be opened from the Session command on the Configure menu.
    Related Topics



To specify a Modem connection
1 Click here        to open the Properties dialog box and click the Connection tab.

2 From the Connection Type list, click Modem and click Configure.
3 Enter the details of the phone number to be connected to and click OK twice.
4 Click the connect button on the terminal emulator toolbar and enter the details of where you are dialing from. Use the 
context sensitive help to obtain additional information on the dialog box controls.

5 Click Dial to start dialing.

Tip
You must have a modem installed to enable this connection type.
This dialog box can be opened from the Session command on the Configure menu.

    Related Topics



To specify an IPX/SPX connection
1 Click here        to open the Properties dialog box and click the Connection tab.

2 From the Connection Type list, click the IPX/SPX protocol NVT2.

Tips
This dialog box can be opened from the Session command on the Configure menu.

    Related Topics



To specify an RS232 connection
1 Click here        to open the Properties dialog box and click the Connection tab.

2 From the Connection Type list, click RS232 and click Configure.
3 Click the type of port to be used and click Properties.
4 This will load the Windows Control Panel System Properties dialog. Select the type of port to be used and confirm the 
properties in this dialog box. Use the context sensitive help to obtain additional information on the dialog box controls.

Tips
Click Show Advanced Ports for a full list of available ports.
This dialog box can be opened from the Session command on the Configure menu.

    Related Topics



To read input from a file using an RS232 connection
Data can be read from a file instead of a remote system and displayed in a terminal emulator using the RS232 connection. The 
data being read may contain text or even escape sequences that could be sent by a remote system. 
You may wish to use this option to read saved remote system escape sequences for the purpose of a demonstration or to 
continuously analyze a PC log file which is constantly being appended to.
1 To select this option, click RS232 from the Connection Type list and click Configure.
2 Click Show Advanced Ports and click Read From File from the drop down list. Click Properties.
3 In the FILE Properties dialog box, select the method for reading a file.



To print to a terminal’s printer port
1 Click here        to open the Properties dialog box.

2 In the Terminal tab, click Configure and click the Printing tab.
3 From the Printer list, select which printer to print to and select the type of font.

Tips
Print jobs will actually be sent to a printer that is connected to your PC.
Appropriate sequences must be sent to the printer to enable and disable the printer.
Enter a timeout value to pause the printer before finally printing the job.
This type of printing is also known as transparent or auxiliary printing.



To use the terminal session wizard
The terminal session wizard provides a step-by-step guide to producing a terminal session.
1 Point to the MultiView 2000 folder and click the Terminal Sessions folder.
2 Click the Add Terminal Session icon to start the wizard.

Tips
All the sessions created by the wizard will be saved in the Terminal Sessions folder.
By default, when the Terminal Emulator application is started a dialog box allows you to choose between using the 

terminal session wizard or opening a blank terminal session.



To specify a default character set (VT220 and VT320)
1 Click here        to open the Properties dialog box.

2 In the Terminal tab, select a VT220 or VT320 from the list of terminal types, click Configure and click the DEC 
Multinational / National Mode tab.
3 Click the required default character set mode.

Tips
The properties dialog box can be opened from the Terminal command on the Configure menu.
To specify the character set to use with National Mode, use the Windows Keyboard application available from Control 

Panel. You must restart the terminal emulator to enable any changes.



Running X clients
When running an X client specified in the Remote Command box of the terminal emulator properties, the X client environment 
must be configured by including the command wrap within the command. 
Below is an example of configuring the environment for the xclock application.
(nohup /usr/bin/X11/xclock -display 35.84.5.93:0 &);exit
where the -display command is followed by your Internet address and a :0. This is where the X client will be displayed.



To transfer files from the PC to a remote system using Kermit
1 To be able to use the Kermit file transfer facility, the Kermit program must be running on the on the remote system before files 

can be sent to the remote system. From the remote system prompt, type one of the commands below to start the program:
kermit -r to send text files to the remote system.
kermit -ri to send binary files to the remote system.

2 From the Transfer menu, click Kermit and click Send Files from the sub-menu.
3 Select the files you want to transfer from the Select Files to Send dialog box.
4 Click OK to send the files to the remote system.
Note: If a file being transferred already exists at the destination, it will be overwritten without a warning

Tip
Click Cancel to abort the current transfer.

    Related Topics



To transfer files from a remote system to the PC using Kermit
1 To be able to use the Kermit file transfer facility, the Kermit program must be running on the remote system before files can be 

sent to the PC. From the remote system prompt, type one of the commands below to start the program:
kermit -s filename to send text files to the PC.
kermit -is filename to send binary files to the PC.
filename can be a single file or group of files selected using a wildcard.

2 From the Transfer menu, click Kermit and click Receive Files from the sub-menu.
3 Once the file has been transferred from the remote system, select a location on the PC to save the file using the Receive dialog

box.
Note: If a file being transferred already exists at the destination, you will be given the chance to confirm whether or not to 
overwrite it.

Tips
Click Cancel to abort the current transfer.
To configure the receive parameters, click Configure from the Kermit menu.

    Related Topics





VT100
All the VT100 features listed in the DECVT100 User Guide are supported EXCEPT for the following:

Feature Sequence
Single width line DECFWL

Hardware related items
Feature Sequence
Screen alignment display DECALN
VT52 mode DECANM
Auto-repeat mode DECARM
Identify terminal DECID
Interface mode DECINLM
Load LEDs DECLL
Request terminal parameters DECREQTPARM
Scrolling mode DECSCLM
Invoke confidence test DESCTST



VT220
All the VT220 features listed in the DECVT220 User Guide are supported EXCEPT for the following:

Feature Sequence
Single width line DECSWL

Hardware related items
Feature Sequence
Auto-repeat mode DECARM
Identify terminal DECID
Interface mode DECINLM
Load LEDs DECLL
Request terminal parameters DECREQTPARM
Scrolling mode DECSCLM
Invoke confidence test DESCTST
Send-receive SRM



VT320
ANSI color extensions and all the VT320 features listed in the DECVT320 User Guide are supported EXCEPT for the following:

Feature Sequence
Single width line DECFWL

Hardware related items
Feature Sequence
Screen alignment display DECALN
VT52 mode DECANM
Auto-repeat mode DECARM
Identify terminal DECID
Interface mode DECINLM
Load LEDs DECLL
Request terminal parameters DECREQTPARM
Scrolling mode DECSCLM
Invoke confidence test DESCTST
Keyboard action KAM
Send-receive SRM
Print Form feed DECPFF
*Character set DECNRCM
ISO Latin Nr 1 supplementary 
character set -
Designating character sets for
supporting Portuguese NRC set SCS
Numeric keypad mode DECNKM
Typewriter or data processing 
keys DECKBUM
Terminal state report DECTSR
Request terminal state report DECRQTSR
Restore terminal state report DECRSTS
Request select or setting DECRQSS
Report selection or setting DECRPSS

*Not supported but may be emulated by using the ISO 7-bit replacement characters sets.



SCO UNIX/XENIX Console 
The SCO UNIX/XENIX emulation is based on the SCO UNIX 3.2 and SCO XENIX 2.3 console.
All the console features as listed in the SCO UNIX System Administrator’s Reference Manual and SCO XENIX System 
Administrator’s Reference Manual are supported EXCEPT for the following:

Feature Sequence
Lock keyboard CSI2h
Unlock keyboard CSI2l
Send bell duration and tone CSI=p;dB
Set cursor size CSI=s;eC
Blink / bold set on / off CSI=xE
Switch screen CSI=nz



Scan code support for SCO UNIX/XENIX Console

Scan code mode is supported in the SCO UNIX/XENIX emulation. To use scan codes in UNIX applications the following 
sequences switch between scan code mode and ASCII character mode:

\E-5 switches into scan code mode.
\E-4 switches out of scan code mode.



WYSE 60
All the WYSE 60 features listed in the WYSE 60 Reference Manual are supported EXCEPT for the following:

Feature
Split screen
Scroll selection - only jump scroll is supported
‘Draw rectangle’ feature used by SMIT (RS6000 configuration tool)
Scan Code Mode
The time displayed on the status line is obtained from the PC and not the remote system





Frequently asked questions about terminal emulators
Q. Why is data being lost or corrupted when it is displayed in a terminal emulator window?

Answer
Q. How can the performance of an active terminal emulator be improved if there are several terminal emulators running?

Answer
Q. Why have my key mappings changed to escape sequences when I have mapped them to terminal keys?

Answer
Q. How can I maximize the display area of a terminal emulator?

Answer
Q. When I use Action As Remote File on some selected text in a terminal emulator, why do I get 'Unable to open the file…'?

Answer
Q. Why do I occasionally get a row of stars (*) in the Password box of the Login dialog box?

Answer



Data can become lost or corrupted when transferred between the network transport and the terminal emulator. The reason for this
is that the unit of data being read at a time is not configured correctly for the transport. Use the Size of Read Buffer in the Session
tab of the Properties dialog to set the appropriate number of bytes to be read.



The rate at which an active terminal window is updated can be improved by suspending updates of inactive terminal windows 
especially those running over slow network connections. This can be done in Session tab of the Properties dialog.



You must have run a remote application which has reprogrammed the mapped keys to escape sequences. On closing your 
application, the default key mappings for the terminal emulator will be restored.



Turn off the toolbar, status bar and set the number of scrollback lines to 0 to maximize the display area.
The terminal emulator will automatically select a suitable font size to be used.



When you login to your remote system using File Transfer, File Transfer will search in the root folder of the logged in user for the 
specified file. If the file cannot be found in this root folder, this message will be displayed.
If you specify the full path from the root directory within the selected text, File Transfer will be able to locate the file and download 
it.



The row of stars indicates that you have previously supplied a password for the specified Login user. Press return to use the 
same password or, enter a different password if required.



TCP/IP Network Protocol Overview 
TCP/IP (Transmission Control Protocol / Internet Protocol) is a network protocol which allows communication between 
interconnected networks. Consisting of 2 protocols, TCP/IP provides a standard set of rules governing how information is passed 
between computers on a network.
The following TCP/IP application-specific protocols are supported:

 TELNET
 RLOGIN
 REXEC
 RSH



TELNET
A TCP/IP application-specific protocol which allows connections to and interaction with networked remote systems. TELNET 
defines the format for the login procedure and the messages sent back to the local system. It also specifies how characters are 
encoded for transmission and how to send special characters which control a session or abort a remote operation.



RLOGIN
A TCP/IP application-specific protocol which allows connections to and interaction with networked remote UNIX systems. Some 
implementations can extend to non-UNIX platforms such as VMS. RLOGIN can be used as an alternative to the TELNET 
protocol. 
RLOGIN will support connections which have been set up not to request a login password. On such occasions, security will be 
compromised.



REXEC
A TCP/IP application-specific protocol that is supported on most UNIX machines. It is of limited use in interacting with remote 
character-based applications, because most applications will not be supported via this protocol. However, it is of significant benefit
for launching remote applications for example, X clients.



RSH
A TCP/IP application-specific protocol that is supported on most UNIX machines. It is of limited use in interacting with remote 
character-based applications, because most applications will not be supported via this protocol. However, it is of significant benefit
for launching remote applications for example, X clients.
RSH requires access to the remote system to be configured in such a way that passwords are not required which will provide an 
insecure connection.



Modem 
Modem connections provide a standard set of rules for connecting to remote systems using binary interchange through a serial 
communications line or telephone network. 
Any data modem configured for Windows® 95 or Windows NT® allows a connection between your PC port (usually COM1, 
COM2, COM3 or COM4) to the remote system serial port via a telephone line.



RS232
RS232 is a communication standard that uses serial binary data interchange. 
A connection is achieved from the PC’s serial port directly to the remote system or via a terminal server which then routes the 
connection to the appropriate remote system.



IPX/SPX Protocol Overview

IPX and SPX are Novell NetWare native communication protocols. IPX is used by the NetWare workstation software to 
communicate with NetWare servers. SPX adds connectivity enhancements to IPX to provide reliable network support. 

The following IPX/SPX application-specific protocol is supported:
 NVT2



NVT2
IPX/SPX application-specific protocols which use a standard to encode information for transmission.



Kermit
Kermit is a file transfer protocol allowing files to be sent from one system to another. To be fully operational, Kermit should be 
running on the system sending the files and the system receiving the files. Files are sent in ASCII format.





MENUS



Opens a new terminal emulator session with default settings.



Opens a terminal emulator session with settings that have been previously saved in a .zzt configuration file.



Saves the settings of the current terminal emulator session in a .zzt configuration file.



Saves the settings of the current terminal emulator session in a .zzt configuration file with the file name and location you specify.



Sends the currently displayed contents of the terminal emulator to the printer connected to your PC.



Shows how the currently displayed contents of the terminal emulator will look when you use the Print command from the File menu.



Uses the default mailer to create a new message. The highlighted text forms the basis of the new message.



Starts a new terminal emulator session using the settings saved in the listed .zzt configuration file. 



Closes the terminal emulator. If you have made any changes to the configuration, you will be asked to confirm the saving of these 
changes.



Copies text that has been highlighted in the terminal emulator to the Clipboard.



Pastes text from the Clipboard to the current cursor position in the terminal emulator.



Copies highlighted text and pastes it at the current cursor position in the terminal emulator in one action.



The toolbar contains buttons that give you quick mouse access to commonly used commands in the terminal emulator menus.
When the command has a check mark next to it, the toolbar is on.



The Color Intensity bar contains controls to change the contrast and brightness of the terminal window.
When the command has a check mark next to it, the toolbar is on.



The status bar displays helpful information and messages while you are using the terminal emulator. 
When the command has a check mark next to it, the status bar is on.



Runs the Rules Agent Editor to configure Active Rules



Allows you to specify settings for the current terminal emulator and the remote application to be run within the emulator.



Allows you to enter details of the remote application to be run within the terminal emulator. 



Allows you to specify settings for the current terminal emulator session, including Start up, General and Connection details.



Allows you to customize the visual appearance of the terminal emulator. 



Allows you to customize terminal type and keyboard mapping properties of the terminal emulator.



Starts sending a file using the Kermit protocol.



Starts recieving a fie using the Kermit protocol.



Stops recieving a file.



Allows you to customise settings for the Kermit protocol.



MORE DETAILS



Allows you to enter login details and then connect to the selected remote system using the current terminal emulator settings.



Disconnects the selected remote system.



Starts a new scripting procedure. The script commands can be saved in a .zzs script file.



Ends the scripting procedure and allows you to save the script commands to a .zzs script file.



Click this menu option to send the User Name when requested by the terminal emulator.



Click this menu option to send the Password when requested by the terminal emulator.



Click this menu option to send the Terminal Type when requested by the terminal emulator.



Click this menu option to send the Remote Application Name when requested by the terminal emulator.



Click this menu option to send the Return character if requested by the terminal emulator.



Allows you to select a saved .zzs script file and run the script commands within the file.



Immediately quits the current script being executed.



DIALOG BOXES



Terminal TAB



Lists the terminal types that can be emulated. Click a terminal type.



Click to configure the colors and display options for the terminal emulator.



When sending the Terminal Type during scripting, this is the string that is sent. The remote system can use this string to set the 
TERM environment variable.



Click to load terminal settings from an existing .zze configuration file.



Click to save the settings from the Terminal Settings dialog box in an .zze configuration file.



Name of the configuration file currently in use.



Displays the Application tab of the Application Properties dialog box.



Displays the Connection tab of the Session Properties dialog box.



Displays the Keyboard tab of the Terminal Properties dialog box.



Displays the Terminal tab of the Terminal Properties dialog box.



Increases the font size being used in the terminal emulator by one point size.



Decreases the font size being used in the terminal emulator by one point size.



Main Terminal Emulator toolbar, drag to detach from the terminal emulator window.



Terminal Settings



Colors tab



Lists all the attributes of the terminal emulator. Click an attribute to configure its color.



Check this box to use the mapped foreground and background colors of the selected attribute in the terminal emulator.



Click to set a foreground color for the selected attribute. If the button is disabled, check the Color Mapped box.



Click to set a background color for the selected attribute. If the button is disabled, check the Color Mapped box.



Shows how the selected attribute will be displayed in the terminal emulator.



Display tab



Displays the number of columns in the terminal emulator.



Displays the number of lines in the terminal emulator. 



Click on the spin buttons to set the number of lines that can be scrolled back in the terminal emulator. The default is 100 lines.



Click to set the cursor in the terminal emulator to a block.



Click to set the cursor in the terminal emulator to a line.



Sets the blink rate of the cursor. Use the slider to adjust the speed.



Shows cursor setting.



CR./LF Tab



When the terminal emulator is receiving keyboard input, carriage returns are not mapped to an alternative sequence.



When the terminal emulator is receiving keyboard input, carriage returns are mapped to carriage return and linefeed sequences.



When the terminal emulator is receiving keyboard input, carriage returns are mapped to linefeed sequences.



When the terminal emulator is sending output, carriage returns are not mapped to an alternative sequence.



When the terminal emulator is sending output, carriage returns are mapped to carriage return and linefeed sequences.



When the terminal emulator is sending output, carriage returns are mapped to linefeed sequences.



Answer Back message tab



Enter a message that is to be returned by the terminal emulator to the remote application when the terminal receives a ENQ (5H) 
character.



Click to place the character for Return in the Message box.



Click to place the character for Tab in the Message box.



Click to place the character for Newline in the Message box.



Click to place the character for Backspace in the Message box.



Click to place the character for Escape in the Message box.



Default Character Set Tab (sco)



Click a default character set from the list to be used by the terminal emulator.



National / Multinational mode (DEC)



Click to specify that the 8-bit multinational is the initial character set used.



Click to specify that the DEC 7-bit National Replacement Character set is used as the default character set.



The national character set currently in use.



Lists the supplemental set for the multinational character set currently in use.
Select the default supplemental set to be used.



Printing Tab



Lists the printers to which terminal emulator print jobs may be sent. Select a printer to be used.



Click to use the default font of the printer.



Click to select a font for printing.



Click to select a font.



Check to specify a timeout value for each print job. The timeout value pauses the printer for the set time to ensure that any further 
output which may be sent within the timeout period is included in the same print job.



Enter the number of seconds to wait before sending the output to the printer.



Session Tab



Type the command or application name to be executed on the remote system when a connection is achieved. This is the string used
when sending the Remote Command during scripting.



Check to run the application specified in the Remote Command box as an X client by starting the X Server on the remote system. 



Type the normal X client prefix. Default is (nohup. 



Type the normal X client suffix. Default is -display nnn.nnn.nnn.nnn:0 &);sleep 5;exit, where nnn.nnn.nnn.nnn is 
the IP address of your PC. The IP address is added during the installation of the PC X server product. 



For advanced users, this option allows you to fine-tune the performance of the terminal emulator for your specific network. The 
default is 2000.



Check this box to immediately update a terminal emulator window when it receives input.



Check this box to suspend updating a terminal emulator window    when it is inactive or in the background.



Reports DDE changes to the client application when the terminal emulator is idle.



Check this box to suspend the terminal emulator from informing the client application of changes. Check to clear this option to 
resume DDE updates.



Startup Tab



Runs a terminal emulator without any startup options.



On saving this option in a .zzt configuration file, the terminal emulator will automatically start connecting to the specified remote 
system when the configuration file is loaded.



On saving this option in a .zzt configuration file, the terminal emulator will automatically start connecting to the remote system 
using the specified script file.



Click to locate a .zze script file to be played.



Check to display the options for creating a terminal session when the Terminal Emulator application is started. Clear check box to 
always run a terminal session with default settings.



Closure Options



Check this box to close the terminal emulator window when disconnected from the remote system.



Check this box to allow you to save changes in a .zzt configuration file when the terminal emulator closes.
Uncheck the box if you do not want to save any changes. You will not be notified of the changes being lost should you choose this 
setting.



Closes the connection to the remote system when Exit or Close is selected from the remote application.



Click to send a sequence to the remote application when it is closing. 



Type the sequence to send to the remote application. Click the Control Character buttons to include these characters in the 
sequence.



Click to place the character for Return in the Sequence box.



Click to place the character for Tab in the Sequence box.



Click to place the character for Newline in the Sequence box.



Click to place the character for Backspace in the Sequence box.



Click to place the character for Escape in the Sequence box.



Keyboard



Click to set keyboard mappings for the terminal emulator in the Keyboard Mapping dialog box.



Click to save the settings from the Keyboard Mapping dialog box in an existing .zzk configuration file.



Click to save the settings from the Terminal Settings dialog box in an .zzk configuration file.



Connection Tab



Select a remote system from the list or type the name of a remote system to be connected to.



Select a user name from the list or type the user name to be used to connect to the remote system.



Click the connection type to be used for connecting to the remote system.



Click to configure the selected connection type.



Check this box to request the user for a password when connecting to the remote system.



Click to locate and open a .zzc configuration file containing saved connection details.



Click to save connection details in a .zzc configuration file.



Enter the port number to be used by the TELNET protocol.



Click to set the TELNET protocol to its default. The default port is 23.



Configure Port Settings



Click a port for the protocol to use when connecting to the remote system.



Properties
Click to configure the settings for the selected port.



Application Help Tab



Type the sequence to send to the remote application to obtain its help. Click the Control Character buttons to include these 
characters in the sequence.



HELP MENU



Displays online help for this MultiView 2000 application.



Displays the Windows online help which provides advice on how to use Help.



Displays the name of the MultiView 2000 application, version and copyright.



Closes this dialog and saves any changes you have made.



Closes this dialog without saving any changes.



Login dialog



Enter the login name used to connect to the remote system.



Enter the password associated with the Login Name to connect to the remote system.



Serial connection port configure



Click a port to use for connections.



Click to configure the details of the port.



Check to show additional port types in the Select Ports list.



Serial connection FILE configure



Click to prompt for a file name each time connection details are to be read from a file.



Click to always read connection details from the specified file.



Displays the file from which to read connection details. Enter the location and name of the file.



Click to locate a file to be read from.



Modem dialing details



Select the country which you dialing to.



Enter the area code for the number being dialed.



Enter the number to be connected to.



Check if the country code and area code are to be used when dialing the number.



Select the type of modem being used.



Dialing Modem



Displays the number to be connected to.



Select where you are dialing from. Click Dial Properties to add a new location.



Displays details of the calling card being used.



Click to edit the displayed phone number.



Click to add a new location from which to dial.



Click to start dialing the phone number.



Startup



Click to open a basic terminal emulator with default settings.



Click to create a terminal session using the Terminal Session Wizard.
To run the wizard directly, click Add Terminal Session in the Terminals Sessions folder.



Check to always choose how to start a terminal session.
Clear the check box to always open a basic terminal emulator with default settings.



Check to display this dialog box when the MultiView 2000 Terminal Emulator has not been set as the default terminal emulator.



To be notified of the MultiView 2000 Terminal Emulator not being the default terminal emulator, check this box.



Popup menu tab



Overall view of the popup menu.



Click to add a new menu item below the currently selected menu item.



Click to add a separator line below the currently selected menu item.



Click to configure the currently selected menu item.



Click to remove the currently selected menu item.



Click to move the currently selected menu item upwards.



Click to move the currently selected menu item downwards.



Click to locate and open a .zzp configuration file containing saved popup menu details.



Click to save the popup menu details in a .zzp configuration file.



Font tab



Click a font to be used by the terminal emulator from the list of fonts.



Click the font style to be used by the terminal emulator from the list of styles.



Click the font size to be used by the terminal emulator from the list of sizes.



Click to display true type fonts in the Font Name box that are fully supported by the terminal emulator.



Click to display all true type fonts in the Font Name box. 
Note: Some characters within these fonts may not be supported by the terminal emulator.



Shows how the selected font will be displayed in the terminal emulator.



Kermit transfer



Shows, in seconds, the maximum interval Kermit waits the remote system for data or an acknowledgement from the PC when 
transferring a file.
Type the number of seconds to wait. The default value is 10, the minimum is 1 and the maximum is 99.



If an error occurs, shows the number of retries Kermit will attempt before closing the connection to the PC.
Type the number of retries. The default value is 10, the minimum is 1 and the maximum is 10.



Restores the following defaults:
Host Receive Timeout, 10 seconds. 
Error Retry Limit, 10 seconds. 



Attribute Mapping Tab



Lists all the character attributes and attribute combinations that are supported by the terminal emulator.
Click an attribute or combination to be used. 



Displays the Attribute Mapping tab of the Application Appearance dialog box.



Shows how the selected attribute or attribute combination will be displayed in the terminal emulator.



Check a box to change the effect of the selected attribute or attribute combination.
Clear a check box to remove an effect.
Note: When using the rules editor, a shaded check box indicates the properties of the character attribute or attribute combinations 
are specified by the application and will be used by default.



Click to select the application’s foreground color mode for the selected attribute or click Select to choose a custom color to be used.



Click to choose a custom foreground color to be used by the selected attribute.



Click to select the application’s background color mode for the selected attribute or click Select to choose a custom color to be used.



Click to choose a custom background color to be used by the selected attribute.



Click to select the text style to be used if required.



Click to select a border style to be used if required.



Click to reset character attributes to their default settings.



Click to specify behavior details of custom colors and borders.



Default attribute



Click to reset the selected character attribute or attribute combination to its default setting.



Click to reset all character attributes and attribute combinations to their default settings.



Advanced appearance



Check to always use the foreground custom color.
Clear the box to enable the foreground color to be specified by the application.



Check to always use the background custom color.
Clear the box to enable the background color to be specified by the application.



When using borders, check to horizontally merge adjacent character cells that consist of the same character attributes.



When using borders, check to horizontally merge adjacent character cells that consist of different character attributes.



When using borders, check to vertically merge adjacent character cells that consist of the same character attributes.



When using borders, check to vertically merge adjacent character cells that consist of different character attributes.



Patterned Border



Click a border style to be used by the terminal emulator.



Click to locate a bitmap for a border style.



Shows the selected border style.



Color Intensity



Drag the slider to increase or decrease the brightness of the terminal window.



Drag the slider to increase or decrease the contrast of the terminal window.



Restricts the effect of brightness and contrast for tones, i.e. white, gray and black.



Click to restore the installed default settings.



Click to restore global settings.



Click to save the current settings as your global settings.



Color Intensity toolbar, drag to detach from the terminal emulator window.



Displays the Color Intensity tab of the Application Appearance dialog



Line Drawing



Click to enable alternative line drawing characters.



Shows the selected line drawing style.



Select the desired style from the list.



Drag the slider to increase or decrease the size of the line drawing characters.





Active URLs dialog



Check to highlight http:// URLs which will load the specified web address in the default web browser.
Shade check box to use System Wide Settings.
Clear check box to not search for this URL type.



Check to highlight file:/// URLs which will execute the specified file.
Shade check box to use System Wide Settings.
Clear check box to not search for this URL type.



Check to highlight ftp:// URLs which will start File Transfer and enable you to login to the specified remote system.
Shade check box to use System Wide Settings.
Clear check box to not search for this URL type.



Check to highlight mailto: URLs which will start Mail and open a new message with the recipient's mail address in the To field.
Shade check box to use System Wide Settings.
Clear check box to not search for this URL type.



Check to highlight news: URLs which will open the specified news group within the web browser.
Shade check box to use System Wide Settings.
Clear check box to not search for this URL type.



Check to highlight gopher: URLs which will open the specified gopher group within the web browser.
Shade check box to use System Wide Settings.
Clear check box to not search for this URL type.



Check to highlight telnet:// URLs which will connect using telnet to the specified remote system using a terminal emulator.
Shade check box to use System Wide Settings.
Clear check box to not search for this URL type.



Check to use Active URLs in the current terminal emulator.



Select whether the specified rules apply to the current terminal emulator only or to all terminal emulators (System Wide Settings) 
which are using Active URLs.



Click this button to save the rules used only by the terminal emulator in a .zzr configuration file.



Click this button to locate and open a .zzr configuration file containing saved rules.



Click this button to set a text foreground color to be used to highlight the active URL.



Click this button to set a text background color to be used to highlight the active URL



Shows how active URLs will be displayed in the terminal emulator.



Click this button to configure additional URL rules.



Advanced Active URLs dialog



Moves the currently selected rule up one position in the rules list.



Moves the currently selected rule down one position in the rules list.



Deletes the currently selected rule.



Adds a new rule to the top of the rules list. If a rule is currently selected, the new rule will be added just below it.



Displays all defined rules.



Displays all defined rules. Double click either part of a rule and click the  button to select a rule argument. Refer to the Technical 
Reference for full details on how to define rules.



Check to also search the System Advanced rules defined in the System Wide Settings.





Overview
The aim of this section is to provide the newcomer with a detailed step-by-step set of procedures describing how to successfully 
connect to a remote system using MultiView 2000 Terminal Emulator.
Where appropriate, the reasons behind the actions you carryout will be explained to help you understand how the terminal 
emulator behaves.
You should follow the procedures in the order in which they are specified.
The different ways in which a terminal emulator can connect to a remote system.
Start configuring a terminal emulator



The different ways of connecting to a remote system using a terminal emulator
MultiView 2000 Terminal Emulator provides several simple ways to connect to a remote system. The methods range from 
manually configuring each terminal property before making a connection to the remote system, through to reading saved terminal 
properties from configuration files to achieve a connection. The configuration files can contain a terminal emulator’s attributes, 
connection properties and remote application details.
Detailed below are the different ways available to use a terminal emulator to connect to a remote system using Terminal Emulator:

manually enter connection and terminal details each time the terminal emulator is opened
retrieving the connection details saved in a connection file (.zzc) and manually specifying terminal settings
retrieving the terminal details saved in a terminal file (.zze) and manually specifying the connection details
retrieving both the terminal details saved in a terminal file (.zze) and the connection details saved in a connection file 

(.zzc)
starting a terminal emulator with preconfigured connection and terminal properties and initiating the connection process 

immediately. All these details are saved in a remote application .zzt configuration file
While the connection is being made, you will need to enter responses to requests from the remote system about the user name 
and password to be used. This part of the connection process can be simplified by automating the responses to the remote 
system requests. 
To automate the responses sent to the remote system, the responses are saved in a script file (.zzs). This script file can then be 
called by the remote application configuration file (.zzt) to completely automate the login procedure.
Click here to start connecting to a remote system



To start a terminal emulator 
Click here    

 to start a terminal emulator.
Next step



To specify connection details
The first step in connecting to a remote system is to specify the name of the remote system and the type of connection.

1 Click the Connection Properties button  on the toolbar to display the Connection tab of the Session Properties dialog box.
2 In the Connection tab, type the name of the remote system to connect to in the Remote System Name box. Alternatively, 
you may be able to click the down arrow in the box to display names of some remote systems which have been entered previously. 
Click a remote system name.
3 In the User Name box, type the user name to be used to login to the specified remote system. Again, you may be able to 
select a name by clicking the down arrow.

4 Next, you will need to specify the connection type to be used to connect to the remote system. Within the Connection Type box,
click the appropriate type of connection for the remote system from the list. You may need to confirm with your system 
administrator which is the correct connection type for your environment.

5 Click the OK button.
The details on connecting to the remote system have now been configured.
Next step



To specify terminal details
The next step is to specify the type of terminal emulator to be used.

1 Click the Terminal Properties button  on the toolbar to display the Terminal tab of the Terminal Properties dialog box.
2 Click the down arrow of the Terminal Type box and click a terminal type to be emulated by the terminal emulator.
3 Click the OK button.

With the connection and terminal details specified, a connection to the remote system can now be made.
Next step



To connect to remote system

1 Click the Connect button  on the toolbar.
2 At the login prompt, type the user name as it was entered in the User Name box in the Connection tab of the Session 
Properties dialog box and press Return.
3 At the Password prompt, enter the password associated with the user name and press Return.
4 As the connection is made, you may be asked for the terminal’s environment variable, TERM. Enter the appropriate 
variable for the emulator type that you are using. Check with your system administrator if you are not sure about the terminal’s 
environment variable.

You should now be successfully logged into the remote system.
To exit from a terminal emulator
To automate connecting to a remote system



To exit from a terminal emulator 
Click the close 

    button in the top right corner of the terminal emulator window.



To start a terminal emulator for automating a connection
This procedure shows you how to automate connecting to a remote system so that a connection can be quickly achieved using 
saved terminal and login details.

Click here    
 to start a terminal emulator.

Next step



To specify details for automating a connection 
The first step is to define the connection and terminal details.
1 Click the Connect Properties button  on the toolbar to display the Connection tab of the Session Properties dialog box.

2 In the Connection tab, type the name of the remote system to connect to in the Remote System Name box. Alternatively, 
you may be able to click the down arrow in the box to display names of some remote systems which have been entered previously. 
Click a remote system name.
3 In the User Name box, type the user name to be used to login to the specified remote system. Again, you may be able to 
select a name by clicking the down arrow.

4 Next, you will need to specify the connection type to be used to connect to the remote system. Within the Connection Type box,
click the appropriate type of connection for the remote system from the list. You may need to confirm with your system 
administrator which is the correct connection type for your environment.

5 Check the Password box if the remote system requires a password for the user name.
6 Click the OK button.
Next step



To specify terminal details for automating a connection
The next step is to specify the type of terminal emulator to be used.

1 Click the Terminal Properties button  on the toolbar to display the Terminal tab of the Terminal Properties dialog box.
2 Click the down arrow of the Terminal Type box and click a terminal type to be emulated by the terminal emulator.
3 In the TERM Environment Variable box, enter the appropriate TERM variable for the emulator type that you are using. 
Check with your system administrator if you are not sure about the terminal’s environment variable.
4 Click the OK button.

Next step



To specify application details for automating a connection
If you want to run a remote application or command when a connection has been made, the next step is to specify the application 
to be used.

1 Click the Application Properties button  on the toolbar to display the Application tab of the Application Properties dialog box.
2 In the Remote Command box type the name of the remote application or the command to be executed when the 
connection is achieved.
3 Click the OK button.
Next step



To configure a script file for automating a connection
With the connection and terminal details specified, a script file to hold all the responses to the requests made by the remote 
system for login details needs to be created.
1 Click Learn Script from the Remote menu. A new scripting toolbar will be added to the terminal window. From this point 

onwards, all the connection actions you carryout will be recorded in the script file.

2 Click the Connect button  on the toolbar.
3 If you checked the Password Required box, the Login To dialog will be displayed requesting the password for the user 
name you are using with the remote system. Enter the password and click the OK button.

4 The remote system may now request the login name. Click the User Name button  and then click the Return button 

 to actually send the user name to the remote system.

5 The remote system may now request the password. Click the Password button  and then click the Return button 

 to actually send the password to the remote system.

6 The remote system may ask for the terminal environment variable, TERM. Click the Terminal Type button  and then 
click the Return button 

.

7 If you have entered a remote command to be executed upon connection, click the Remote Application Name button  
and then click the Return button 

.

8 Finally, click the End Script button     to save the responses to the remote system requests in a script file.
9 In the File name box, enter a name for the script file. Script files use a .zzs extension.
Next step



To create a file to automate connecting to a remote system
At this stage you should be connected to the remote system. A few more steps need to be completed to fully automate the 
process for subsequent connections to the remote system.
The saved script file should now be automatically called by the terminal emulator as follows:
1 Click the Connect button  on the toolbar to display the Connection tab of the Session Properties dialog box. Click the Startup 

tab.
2 Click Auto Replay Script File from the Startup Options and click the Browse button.
3 Locate and select the script file (.zzs) that you have just saved and click OK. Click OK in the Properties dialog box.
4 From the terminal emulator’s File menu, click Save to save all the connection, terminal and script file details required to 
automatically login to the remote system in a remote application configuration file (.zzt).

5 In the File name box, enter a name for the remote application file (.zzt) and click Save.
Next step



To use a remote application configuration file
The next time you need to connect to this remote system from a blank terminal emulator, you simply open the saved remote 
application configuration file (.zzt) using the Open command on the File menu.
Alternatively, you can double click the remote application configuration file (.zzt) from Windows Explorer to open a terminal 
emulator to start the connection process.





Record the login procedure in a script file
Use the scripting toolbar to record the login procedure as follows:

1 If applicable, at the login prompt, click the User Name button  to enter your user name.

Click the Return button  to send your user name.

2 At the password prompt, click the Password button  to enter your password.
Click the Return button  to send your password.

3 If applicable, at the terminal type prompt, click the Terminal Type button  to enter the Terminal Type.
Click the Return button  to send the terminal type.

4 Optionally, if you have configured a remote command in the terminal session wizard, at the remote system prompt, click the 

Remote Command button  to record and send the remote command.
Click the Return button .

5 Click the Stop Learning Script button  to end the learn procedure and save the script to a file.

Tips
This saved script file will automatically be called when the terminal session is next started.
The script file is saved with a .zzs extension in the default MultiView 2000 folder.
All the script commands are also available from the Remote menu.
If you click an incorrect button while creating the script, follow these guidelines.
After step 4, it is possible to enter one or more commands (separated by a carriage return) at the terminal prompt which 

can also be included in the script file.



To correct a problem with a script
The following procedure will not continually be displayed while the actions are carried out. Therefore, you may want to take note 
or print this topic for reference.
1 Click the Stop Learning Script button  to end the learn procedure and press Cancel in the Save As dialog box.

2 Click the Disconnect button  on the terminal emulator’s toolbar.
3 Click Learn Script from terminal emulator’s Remote menu.

The terminal session will start again with the scripting guide available to create a new script file.

Return to recording a login procedure in a script file.





Overview of active URLs
Active URLs allow for the integration between the Terminal Emulator and other Windows applications, for example File Transfer or
a web browser, based upon a set of rules or conditions being satisfied.
A rule is defined in two parts; the condition that must be matched and if matched, the action to be invoked. When a piece of text 
satisfies an active URL rule, the text is highlighted and can be clicked. On clicking the highlighted text, the action assigned in the 
rule will be initiated.
There are two types of rules that can be defined:

1. Basic active URLs which search for the following text and invoke the default application when clicked:
http:// Opens the default web browser with the specified address.
file:/// Opens the specified local file.
ftp:// Opens File Transfer
news: Opens the specified news group in the default web browser.
gopher: Lists the specified gopher menu.
telnet:// Opens a terminal emulator and logs onto the specified remote system.

2. Additional active URLs which can be constructed to search for any specific condition and then initiate a particular action if the 
condition is matched. Click here for further details on defining additional URLs.



To configure an active URL
1 Click here        to open the terminal emulator Properties dialog box and click the Active URLs tab.

2 Check Enable Active URLs.
3 From the Configure list, select whether the specified Active URLs apply to the current terminal session (Session Settings) 
or to all terminal emulators that use Active URLs (System Wide Settings).
4 In the Search For: box, check the URL types to be highlighted.

Tips
If configuring the current terminal emulator settings, by default, the URL types that are searched for are specified in the 

system wide settings (indicated by a shaded check box).
Check a box to search for a URL type.
Shade a check box to use the system wide setting.
Clear a check box to not search for a URL type.
This dialog box can be opened from the Properties command on the Configure menu.

    Related Topics



To use an active URL
1 Within a terminal emulator, type a URL address.
2 The text of the URL should become highlighted. Click this text.

Tip
Make sure that the URL type you are entering has been activated by checking its option in the Active URLs tab. 



To configure the color of active URLs
1 Click here        to open the terminal emulator Properties dialog box and click the Active URLs tab.

2 Click the Foreground button to select the foreground color of the active URLs text.
3 Click the Background button to select the background color of the active URL text.



To include additional URL rules
1 Click here        to open the terminal emulator Properties dialog box and click the Active URLs tab.

2 Click the Advanced tab and click the New button.
3 Double click the Replace part of the rule and click  to use the rules shortcut menu to specify the condition to be 
matched.
4 Double click the With part of the rule and click  to use the shortcut menu to specify the action to be taken when the rule
becomes highlighted and is clicked.

Tip
Make sure that the URL type you are entering has been activated by checking its option in the Active URLs tab. 

    Related Topics



To configure terminal-specific active URLs
1 Click here        to open the terminal emulator Properties dialog box and click the Active URLs tab.

2 Select Session Settings from the Configure box and check the URL types to be activated from the Search For: box.

Tips
Check a box to search for a URL type.
Shade a check box to use the system wide setting.
Clear a check box to not search for a URL type.

    Related Topics



To save terminal-specific active URLs
1 Click here        to open the terminal emulator Properties dialog box and click the Active URLs tab.

2 Select Session Settings from the Configure box and check the URL types to be activated from the Search For: box.
3 Click Save As in the URL Rules File box.
4 If you have not saved your file before, type a name for the file in the File Name box and click Save As.

The URL rules details will be saved in a file with the extension .zzr.
    Related Topics



Defining additional active URL rules
An additional active URL is composed of two parts; the Replace condition and the With condition. 
The Replace condition must be satisfied before the With condition can be acknowledged (by highlighting the text that meets the 
condition) and be able to carry out its assigned action.
To define the Replace and With conditions of an active URL, a shortcut menu is available to help you.

The shortcut menu is designed to provide you with all the possible arguments you would need to construct an active URL rule.
Above the shortcut menu's separator bar, all the URL types that are supported are listed. Below the separator bar are the 
arguments that you may need to specify any conditions. The conditions can range from a simple single text word to a variable 
which can be passed from the Replace condition of the rule to the With condition of the rule.
The best way to demonstrate how to construct an active URL rule is by the following example.
Example 1:A remote system contains the location of a reference file held on a local PC. Clicking on the text specifying the 

location within a terminal emulator will open the relevant PC file.



Defining active URL rules Example 1
A remote system contains the location of a reference file held on a local PC. Clicking on the text specifying the location within a 
terminal emulator will open the relevant PC file.

Replace condition: <NH>Document Location: [</NH>c:\<P1><*>.<?><?><?></P1><NH>]</NH>
With condition: file:///c:\<P1>
The full path of a file with a three character extension can be specified.
The active URL can be entered as follows:
1 Enter the Replace part of the rule by firstly clicking the New button and deleting any default text in the condition. Next enter the 

following: 
Document Location: [

2 Select all the text and click the shortcut menu button  and click Do Not Highlight. 
3 After the end tag for Do Not Highlight (</NH>), enter:
c:\ and click Wildcard from the shortcut menu.
Enter a dot (.) and click Character from the shortcut menu three times.

4 Select the <*>.<?><?><?> text and click Parameter from the shortcut menu.
5 At the end of the rule, add a ] to indicate the end of the field, select the bracket and click Do Not Highlight from the shortcut 

menu.
Now specify the With condition part of the rule as follows:
6 Double click the With condition part of the rule and delete any default text in the condition.
7 Click the shortcut menu button and click Local File.
8 Enter:

c:\ and then click Parameter from the shortcut menu.
9 Click OK.






